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Chapter 165 

Equivalence Tests for the 
Difference Between Two 
Correlated Proportions 
Introduction 
The procedure described in this chapter compute power and sample size for testing equivalence using differences 
in designs in which two dichotomous responses are measured on each subject. 

When one is interested in showing that two correlated proportions are different, the data are often analyzed with 
McNemar’s test. However, the procedures discussed here are interested in showing equivalence rather than 
difference. For example, suppose a diagnostic procedure is accurate, but is expensive to apply or has serious side 
effects. A replacement procedure may be sought which is equally accurate, but is less expensive or has fewer side 
effects. In this case, we are not interested in showing that the two diagnostic procedures are different, but rather 
that they are the same. Equivalence tests were designed for this situation.  

These tests are often divided into two categories: equivalence (two-sided) tests and non-inferiority (one-sided) 
tests. Here, the term equivalence tests means that we want to show that two diagnostic procedures are 
equivalent—that is, their accuracy is about the same. This requires a two-sided hypothesis test. On the other hand, 
non-inferiority tests are used when we want to show that a new (experimental) procedure is no worse than the 
existing (reference or gold-standard) one. This requires a one-sided hypothesis test. 

Technical Details 
The results of a study in which two dichotomous responses are measured on each subject can be displayed in a 2-
by-2 table in which one response is shown across the columns and the other is shown down the rows. In the 
discussion to follow, the columns of the table represent the standard (reference or control) response and the rows 
represent the treatment (experimental) response. The outcome probabilities can be classified into the following 
table. 

 

 

In this table, . That is, the first subscript represents the response of the new, experimental 

procedure while the second subscript represents the response of the standard procedure. Thus,  represents the 
proportion having a negative treatment response and a positive standard response.  
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Sensitivity, Specificity, and Prevalence 
To aid in interpretation, analysts have developed a few proportions that summarize the table. Three of the most 
popular ratios are sensitivity, specificity, and prevalence.  

Sensitivity 
Sensitivity is the proportion of subjects with a positive standard response who also have a positive experimental 
response. In terms of proportions from the 2-by-2 table,  

Sensitivity =  

Specificity 
Specificity is the proportion of subjects with a negative standard response who also have a negative experimental 
response. In terms of proportions from the 2-by-2 table,  

Specificity =  

Prevalence 
Prevalence is the overall proportion of individuals with the disease (or feature of interest). In terms of proportions 
from the 2-by-2 table,  

Prevalence =  

Table Probabilities 
The outcome counts from a sample of n subjects can be classified into the following table. 
 

 

 

Note that  is the number of matches (concordant pairs) and  is the number of discordant pairs. 

The hypothesis of interest concerns the two marginal probabilities  and .  represents the accuracy or 
success of the standard test and  represents the accuracy or success of the new, experimental test. Equivalence 
is defined in terms of either the difference, , or the relative risk ratio, , of these two 
proportions. The choice between D and R will usually lead to different sample sizes to achieve the same power. 
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Equivalence Hypotheses using Differences 
This section is based on Liu, Hsueh, Hsieh and Chen (2002). We refer you to that paper for complete details.  

The hypotheses of equivalence in terms of the difference are 

 

These hypotheses can be decomposed into two sets of one-sided hypotheses  

 

and 

 

The hypothesis test of equivalence with type I error rate  is conducted by computing a % 
confidence interval for  and determining if this interval is wholly contained between  and . This 
confidence interval approach is often recommended by regulatory agencies. 

Liu et al. (2002) discuss the RMLE-based (score) method for constructing these confidence intervals. This method 
is based on (developed by, described by) Nam (1997). 

Asymptotic Tests 
An asymptotic test for testing  versus  is given by 

 

where 

 

 

 

and  is the standard normal deviate having  in the right tail.  

Similarly, an asymptotic test for testing H0U versus H1U  is given by 

. 

Equivalence is concluded if both the tests on ZL and ZU are rejected. 

An estimate of σ̂  based on the RMLE-based (score) procedure of Nam (1997) uses the estimates 
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where 

 

 

 

 

 

 

 

 

Note that the ICH E9 guideline (see Lewis (1999)) suggests using a significance level of  when testing this 
hypothesis. 

Power Formula 
The power when the actual difference is  can be evaluated exactly using the multinomial distribution. 
However, when the sample size is above a user-set level, we use a normal approximation to this distribution 
which leads to 
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Nuisance Parameter 
Unfortunately, the 2-by-2 table includes four parameters p p p11 10 01, , , and p00 , but the power specifications 
above only specify two parameters: PS  and DA  or RA . A third parameter is defined implicitly since the sum of 
the four parameters is one. One parameter, known as a nuisance parameter, remains unaccounted for. This 
parameter must be addressed to fully specify the problem. This fourth parameter can be specified by specifying 
any one of the following: p p p p11 10 01 00, , , , p p p p10 01 11 00+ +, ,  or the sensitivity of the experimental response, 
p P11 / S . 

It may be difficult to specify a reasonable value for the nuisance parameter since its value may not be even 
approximately known until after the study is conducted. Because of this, we suggest that you calculate power or 
sample size for a range of values of the nuisance parameter. This will allow you to determine how sensitive the 
results are to its value. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the Design tab. For 
more information about the options of other tabs, go to the Procedure Window chapter. 

Design Tab 
The Design tab contains the parameters associated with this test such as the proportions, sample sizes, alpha, and 
power. 

Solve For 

Solve For 
This option specifies the parameter to be solved for from the other parameters. The parameters that may be 
selected are Power or Sample Size.  
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Power Calculation 

Power Calculation Method 
Select the method to be used to calculate power. 

The choices are 

• Multinomial Enumeration 
Power is computed using multinomial enumeration of all possible outcomes when N ≤ Max N for 
Multinomial Enumeration (otherwise, the normal approximation is used). Multinomial enumeration of all 
outcomes is possible because of the discrete nature of the data. 

• Normal Approximation 
Approximate power is computed using the normal approximation to the multinomial distribution. 

The exact calculation using the multinomial distribution becomes very time consuming for N > 500. When N > 
500, the difference between the multinomial and approximate calculations is small.  

For small values of N (less than 100), the Multinomial Enumeration power may be overly optimistic because the 
discrete nature of the trinomial distribution results in the actual alpha value being higher than its target. To be on 
the safe side, we recommend that you use the approximate calculation. 

Max N for Multinomial Enumeration 
Only shown when Power Calculation Method = “Multinomial Enumeration” 

Specify the maximum value of N (sample size) that uses the exact power calculation based on the multinomial 
distribution. N's greater than this value will use the asymptotic approximation. 

Power and Alpha 

Power 
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, 
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when you fail to conclude 
equivalence when in fact it is true. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 
0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.  

Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true 
null hypothesis is rejected. Here, a type-I error occurs when you falsely conclude equivalence.  

Sample Size 

N (Sample Size) 
Enter a value for the sample size. This value must be greater than two. You may enter a range of values such as 10 
to 100 by 10.  
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Effect Size – Differences 

|De| (Equivalence Difference) 
|De| is the maximum allowable difference between the standard and treatment proportions that will still result in 
the conclusion of equivalence. 

Only positive values can be entered here. Typical values for this difference are 0.05, 0.10, and 0.20. For 2-sided 
tests, you must have |Da| < |De|. 

Da (Actual Difference) 
Enter Da, the actual difference between the standard and treatment proportions (Pt - Ps). This value is used to 
generate the value of Pt using the formula Pt = Ps + Da. 

Often this value is set equal to zero, but this is not necessary. For 2-sided tests, you must have |Da| < |De|. 

Effect Size – Standard Proportion 

Ps (Standard Proportion) 
This is the proportion of yes’s (or successes), PS , when subjects received the standard treatment. This value or a 
good estimate is often available from previous studies.  

Note that this value does not matter when the Nuisance Parameter Type is set to “P01” (or “P10”), as long as it is 
greater than P01 (or P10). 

You may enter a set of values separated by blank spaces. For example, you could enter 0.50 0.60 0.70. Values 
between, but not including, 0 and 1 are permitted. 

Effect Size – Nuisance Parameter 

Nuisance Parameter Type 
Enter the type of nuisance parameter here. Unfortunately, the 2-by-2 table cannot be completely specified by 
using only the parameters Ps and Da or Ps and Ra. One other parameter must be specified. This additional 
parameter is called a “nuisance” parameter. It will be assumed to be a known quantity. Several possible choices 
are available. This option lets you specify which parameter you want to use. In all cases, the value you specify is a 
proportion. 

• P11 (% Positive Matches) 
The proportion of subjects that are positive on both tests. 

• P00 (% Negative Matches) 
The proportion of subjects that are negative on both tests. 

• P01 (% -Trt +Std) 
The proportion of subjects that are negative on the treatment, but positive on the standard. 

• P10 (% +Trt -Std) 
The proportion of subjects that are positive on the treatment, but negative on the standard. 

• P11+P00 (% Matches) 
The proportion of matches (concordant pairs). 

• P01+P10 (% Disagree) 
The proportion of non-matches (discordant pairs). 
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• P11/Ps (Sensitivity) 
The sensitivity. 

Nuisance Parameter Value 
Enter the value of the nuisance parameter that you specified in the “Nuisance Parameter Type” box. This value is 
a proportion, so it must be between 0 and 1.  

Example 1 – Finding Power 
A clinical trial will be conducted to show that a non-invasive MRI test is equivalent to the invasive CTAP 
reference test. Historical data suggest that the CTAP test is 80% accurate. After careful discussion, the researchers 
decide that if the MRI test is within five percentage points of the CTAP, it will be considered equivalent. They 
decide to use a difference test statistic. Thus, the equivalence difference is 0.05. They want to study the power for 
various sample sizes between 200 and 1000 at the 5% significance level.  

They use P01 as the nuisance parameter and look at two values: 0.05 and 0.10.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Equivalence Tests for the Difference Between Two Correlated Proportions procedure 
window by expanding Proportions, then Two Correlated Proportions, then clicking on Non-Inferiority, and 
then clicking on Equivalence Tests for the Difference Between Two Correlated Proportions. You may then 
make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Power Calculation Method ...................... Normal Approximation 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 200 300 450 600 800 1000 
|De| (Equivalence Difference) ................. 0.05 
Da (Actual Difference) ............................ 0.0 
Ps (Standard Proportion) ........................ 0.80 
Nuisance Parameter Type ...................... P01 (% -Trt +Std) 
Nuisance Parameter Value ..................... 0.05 0.10 
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Annotated Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for an Equivalence (Two-Sided) Test of a Difference 
 
 Sample Equiv. Actual Treatment Standard Nuisance 
 Size Difference Difference Proportion Proportion Parameter 
Power N |De| Da Pt Ps P01 Alpha 
0.35542 200 0.050 0.000 0.800 0.800 0.050 0.050 
0.00000 200 0.050 0.000 0.800 0.800 0.100 0.050 
0.66488 300 0.050 0.000 0.800 0.800 0.050 0.050 
0.20739 300 0.050 0.000 0.800 0.800 0.100 0.050 
0.88574 450 0.050 0.000 0.800 0.800 0.050 0.050 
0.51491 450 0.050 0.000 0.800 0.800 0.100 0.050 
(report continues) 
 
* Power was computed using the normal approximation method. 
 
Report Definitions  
Power is the probability of rejecting a false null hypothesis. 
N is the number of subjects, the sample size. 
|De| is the maximum difference between the two proportions that is still called 'equivalent.' 
Da is the actual difference between Pt and Ps. That is, Da = Pt-Ps. 
Pt is the response proportion to the treatment (experimental or new) test. 
Ps is the response proportion to the standard (reference or old) test. 
The Nuisance Parameter is a value that is needed, but is not a direct part of the hypothesis. 
Alpha is the probability of rejecting a true null hypothesis. 
 
Summary Statements 
A sample size of 200 subjects achieves 35.542% power at a significance level of 0.050 using a 
two-sided equivalence test of correlated proportions when the standard proportion is 0.800, the 
maximum allowable difference between these proportions that still results in equivalence (the 
range of equivalence) is 0.050, and the actual difference of the proportions is 0.000. 

 
This report shows the power for the indicated scenarios. All of the columns are defined in the “Report 
Definitions” section. 

Plots Section 
 

      
 
These plots show the power versus the sample size for the two values of P01. In this example, we see that the 
value of the nuisance parameter has a large effect on the calculated sample size.  
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Example 2 – Finding Sample Size 
Continuing with Example 1, the analysts want to determine the exact sample size necessary to achieve 90% power 
for both values of the nuisance parameter.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Equivalence Tests for the Difference Between Two Correlated Proportions procedure 
window by expanding Proportions, then Two Correlated Proportions, then clicking on Non-Inferiority, and 
then clicking on Equivalence Tests for the Difference Between Two Correlated Proportions. You may then 
make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Power Calculation Method ...................... Normal Approximation 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
|De| (Equivalence Difference) ................. 0.05 
Da (Actual Difference) ............................ 0.0 
Ps (Standard Proportion) ........................ 0.80 
Nuisance Parameter Type ...................... P01 (% -Trt +Std) 
Nuisance Parameter Value ..................... 0.05 0.10 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for an Equivalence (Two-Sided) Test of a Difference 
 
 Sample Equiv. Actual Treatment Standard Nuisance 
 Size Difference Difference Proportion Proportion Parameter 
Power N |De| Da Pt Ps P01 Alpha 
0.90019 468 0.050 0.000 0.800 0.800 0.050 0.050 
0.90002 881 0.050 0.000 0.800 0.800 0.100 0.050 
 
* Power was computed using the normal approximation method. 

 
This report shows that the sample size required nearly doubles when P01 is changed from 0.05 to 0.10. 
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Example 3 – Finding Power Following an Experiment 
An experiment involving a single group of 57 subjects was run to show that a new treatment was equivalent to a 
previously used standard. Historically, the standard treatment has had a 48% success rate. The new treatment is 
known to have similar side effects to the standard, but is much less expensive. The treatments were to be 
considered equivalent if the success rate of the new treatment is within 10% of the success rate of the standard.  

To compare the new and standard treatments, each of the 57 subjects received both treatments with a washout 
period between them. Thus, the proportions based on the two treatments are correlated. Of the 57 subjects, 18 
responded to both treatments, 20 did not respond to either treatment, 9 responded to the new treatment but not the 
standard, and 10 responded to the standard but not the new treatment. The proportion responding to the new 
treatment is (18+9)/57 = 0.4737. The proportion responding to the standard is (18+10)/57 = 0.4912. The 
difference is 0.0175, lower than the threshold for equivalence, but the resulting p-value was 0.3358, indicating the 
two treatments could not be deemed equivalent at the 0.05 level. Note that McNemar’s test only uses the 
discordant pairs, so the effective size of this study is really only 9 + 10 = 19, although 57 subjects were 
investigated. The researchers want to know the power of the test they used. 

It may be the inclination of the researchers to use the observed difference in proportions for calculating power. 
The p-value, however, is based on the maximum allowable difference for equivalence, which is 10% of 0.48, or 
0.048. This is the number that should be used in the power calculation. The experiment gave a value of P01 of 
10/28 = 0.36. The power of the experiment is near zero for all values of P01 less than 0.10. We calculate the 
power for a variety of nuisance parameter values (P01 = 0.01, 0.03, 0.05, and 0.10) to monitor its effect. Because 
it is in fact believed that the success rates are equivalent for the two treatments, the specified actual difference is 
set to 0. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Equivalence Tests for the Difference Between Two Correlated Proportions procedure 
window by expanding Proportions, then Two Correlated Proportions, then clicking on Non-Inferiority, and 
then clicking on Equivalence Tests for the Difference Between Two Correlated Proportions. You may then 
make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Power Calculation Method ...................... Multinomial Enumeration 
Max N for Multinomial Enumeration ....... 1000 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 57 
|De| (Equivalence Difference) ................. 0.048 
Da (Actual Difference) ............................ 0.0 
Ps (Standard Proportion) ........................ 0.48 
Nuisance Parameter Type ...................... P01 (% -Trt +Std) 
Nuisance Parameter Value ..................... 0.01 0.03 0.05 0.10 
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Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for an Equivalence (Two-Sided) Test of a Difference 
 
 Sample Equiv. Actual Treatment Standard Nuisance 
 Size Difference Difference Proportion Proportion Parameter 
Power N |De| Da Pt Ps P01 Alpha 
0.31614 57 0.048 0.000 0.480 0.480 0.010 0.050 
0.02940 57 0.048 0.000 0.480 0.480 0.030 0.050 
0.00247 57 0.048 0.000 0.480 0.480 0.050 0.050 
0.00000 57 0.048 0.000 0.480 0.480 0.100 0.050 
 
* Power was computed using multinomial enumeration of all possible outcomes. 

 

Note that there is no power for value of P01 greater than 0.05. This is probably due to the low number of 
discordant pairs. 

Example 4 – Validation using Liu et al. (2002) 
Liu et al. (2002) page 238 give a table of power values calculated by multinomial enumeration for sample sizes of 
50, 100, and 200 when the significance level is 0.05. From this table, we find that when P01 is 0.10, P10 is 0.10, 
Da = P01 - P10 = 0.00, and De is 0.10, and the three power values are 0.026, 0.417, and 0.861 for the column 
head “RMLE-based Without CC” (this is the case we use).   

In their calculations, they round the z value to 1.64. This corresponds to an alpha value of 0.0505025835. So that 
our results match, we will use this value for alpha rather than 0.05. In this example, the value of Ps is not used. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Equivalence Tests for the Difference Between Two Correlated Proportions procedure 
window by expanding Proportions, then Two Correlated Proportions, then clicking on Non-Inferiority, and 
then clicking on Equivalence Tests for the Difference Between Two Correlated Proportions. You may then 
make the appropriate entries as listed below, or open Example 4 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Power Calculation Method ...................... Multinomial Enumeration 
Max N for Multinomial Enumeration ....... 1000 
Alpha ....................................................... 0.0505025835 
N (Sample Size) ...................................... 50 100 200 
|De| (Equivalence Difference) ................. 0.1 
Da (Actual Difference) ............................ 0.0 
Ps (Standard Proportion) ........................ 0.5 
Nuisance Parameter Type ...................... P01 (% -Trt +Std) 
Nuisance Parameter Value ..................... 0.1 
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Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for an Equivalence (Two-Sided) Test of a Difference 
 
 Sample Equiv. Actual Treatment Standard Nuisance 
 Size Difference Difference Proportion Proportion Parameter 
Power N |De| Da Pt Ps P01 Alpha 
0.02614 50 0.100 0.000 0.500 0.500 0.100 0.051 
0.41741 100 0.100 0.000 0.500 0.500 0.100 0.051 
0.86080 200 0.100 0.000 0.500 0.500 0.100 0.051 
 
* Power was computed using multinomial enumeration of all possible outcomes. 
 

As you can see, the values computed by PASS match the results of Liu et al. (2002). 
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